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1. Definitions 
1.1 Unless the context otherwise requires, expressions not defined in this Allotment 

Document, but defined in the Act or the Rules shall have the meaning assigned 

thereto in the Act or the Rules, as the case may be. 

1.1.1. “Acceptable Bank” shall mean a Scheduled Bank as listed in the Second Schedule of 

the Reserve Bank of India Act, 1934 excluding those listed under the headings of 

Gramin Banks, Urban Co-operative Banks and State Co-operative Banks.  

1.1.2. “Act” shall mean the Coal Mines (Special Provisions) Act, 2015. 

1.1.3. “Allotment” means allotment of identified coal mines to Government company or 

corporation or to a joint venture between two or more Government companies or 

corporations under provisions of Rule 11 (1) of the Rules. 

1.1.4. “Allotment Agreement” means the agreement to be executed between the 

Nominated Authority and Allottee in substantially the same format as provided at 

Annexure V. 

1.1.5. “Allotment Document” shall mean this document and its Annexures including 

specifically the Allotment Agreement, the Mine Dossier, notification No. 

13016/9/2014‐CA‐III dated Dec 26, 2014 of Ministry of Coal, any addenda to this 

Allotment Document and any other document issued pursuant hereto.  

1.1.6. “Allotment Order” shall mean the allotment order issued under Section 5 of the Act. 

1.1.7. “Allottee” shall have the meaning ascribed thereto in Clause 3.4.2(d). 

1.1.8. “Applicable Law” shall mean all applicable statutes, laws, by-laws, rules, 

regulations, orders, ordinances, protocols, codes, guidelines, policies, notices, 

directions, judgments, decrees or other requirements or official directive of any 

governmental authority or court or other law, rule or regulation approval from the 

relevant governmental authority, government resolution, directive, or other 

government restriction or any similar form of decision, or determination, or any 

interpretation or adjudication having the force of law in India. 

1.1.9. “Applicant” means any entity that participates in the Allotment process by 

submitting the Application for the Coal Mine. 

1.1.10. “Application” shall mean the application submitted by an Applicant pursuant to this 

Allotment Document on the electronic platform of MSTC and shall include the 
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Affidavit and the Power of Attorney required to be submitted physically to the 

Nominated Authority. 

1.1.11. “Authorised Signatory” shall mean the individual representing an Applicant who 

has been duly authorised on behalf of such Applicant to execute and submit the 

Application in accordance with the terms hereof.  

1.1.12. “CIL Notified Price” shall mean the prevailing notified price of relevant grade(s) of 

coal by Coal India Limited or any of its subsidiaries, as may be territorially relevant 

to the Coal Mine. 

1.1.13. “Coal Mine” means a Schedule I coal mine referred in Annexure VI. 

1.1.14. “Eligibility Conditions” shall mean the eligibility conditions specified in the Act and 

the Rules including all the eligibility conditions listed in Clause 3.2.  

1.1.15. “Fixed Amount” shall have the meaning ascribed thereto in Clause 3.4.3(b).  

1.1.16. “Last Date” shall mean the date on which the Application is required to be submitted 

in accordance with Clause 3.6.1. 

1.1.17. “Mine Dossier” shall have the meaning ascribed thereto in the Rules. 

1.1.18. “MSTC” shall mean MSTC Limited (a Government of India undertaking). 

1.1.19. “Nominated Authority” shall mean the Nominated Authority appointed under 

section 6 (1) of the Act and the Rules framed there under. 

1.1.20. “Performance Security” shall have the meaning ascribed thereto in Clause 7. 

1.1.21. “Person” shall include any company or association or body of individuals, whether 

incorporated or not. 

1.1.22. “Preferred Applicant” shall have the meaning ascribed thereto in Clause 3.4.2; 

1.1.23. “Prior Allottee” shall have the meaning ascribed thereto in the Act and for the 

purposes of the Coal Mine, the Prior Allottee shall be as specified against each Coal 

Mine in Annexure VI.  

1.1.24. “Reference Index” shall mean the pre-specified escalation formula that is prescribed 

in the prevailing bidding document for Case 1 bidding as formulated by Ministry of 

Power for escalation of fuel cost from captive mines. 

1.1.25. “Reserve Price” shall have the meaning ascribed thereto in Clause 3.8.1. 
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1.1.26. “Rule 8(2) Order” shall mean the Order No.  CBA2-13011/5/2019-CBA2 dated July 

19, 2019, as amended, issued by the Central Government under Rule 8(2) of the Rules. 

1.1.27. “Rules” shall mean the Coal Mines (Special Provisions) Rules, 2014 or any other rules 

framed pursuant to the Act. 

1.1.28. “Specified End Use Plant(s)” shall mean one or more plant owned by the Applicant 

located in India and engaged in the Specified End Use. 

1.1.29. “Specified End Use” shall have the meaning ascribed thereto in Clause 2.3.1. 

1.1.30. “Supreme Court Judgment” shall have the meaning ascribed thereto in Clause 2.1.1. 

1.1.31.  “Upfront Amount” shall have the meaning ascribed thereto in Clause 0.  
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2. Introduction 

2.1. Background 

2.1.1. The Supreme Court of India through its judgment dated August 25, 2014 read with 

its order dated September 24, 2014 (collectively the “Supreme Court Judgment”) had 

cancelled allotment of 204 coal blocks. The Coal Mine was included in the list of such 

204 coal blocks and accordingly, its allotment to the Prior Allottee was cancelled 

pursuant to the Supreme Court Judgment, with effect from the „appointed date‟ (as 

defined in the Act). 

2.1.2. Subsequent to the Supreme Court Judgment, the Coal Mines (Special Provisions) 

Ordinance, 2014; the Coal Mines (Special Provisions) Second Ordinance, 2014 were 

promulgated, the Rules were framed; and the Act was passed for auction and 

allotment of all blocks which suffered cancellation pursuant to Supreme Court 

Judgment.  

2.1.3. In exercise of the powers conferred by Section 6 (1) of the Act, the Government of 

India (the “Central Government” or “GoI”) has appointed the Nominated Authority 

to allocate Schedule I coal mines as defined in the Act. In terms of Section 6(3) of the 

Act, the Central Government is required to act through the Nominated Authority for 

conduct of the allotment process. 

2.1.4. The Central Government has also issued a „Rule 8(2) Order‟ dated July 19, 2019, as 

amended, to the Nominated Authority for allotment of the Coal Mine pursuant to 

Section 5 (1) of the Act. A copy of such Rule 8(2) Order is available at: 

http://coal.nic.in.  

2.1.5. Accordingly, this Allotment Document is being issued by the Central Government 

through the Nominated Authority for Allotment of the Coal Mine. 

2.2. The Act and the Rules 

2.2.1. Applicants are encouraged to familiarise themselves with the Act and the Rules. As 

of the date of this Allotment Document, the Act and the Rules are available at: 

http://coal.nic.in. 

2.3. The Coal Mine 

2.3.1. The Coal Mine is being allotted strictly for the purpose of own consumption of coal 

for production of iron & steel (coking coal) as mentioned in the Rule 8(2) Order. (the 

“Specified End Use”).  

http://coal.nic.in/
http://coal.nic.in/
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2.3.2. The mining operations are required to be conducted strictly in accordance with all 

Applicable Law, including without limitation the Act, the Rules, the Allotment Order 

and this Allotment Document and any document referred herein, including the 

Allotment Agreement. 
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3. Allotment Process 

3.1. Allotment Document 

3.1.1. The Notice Inviting Application (the “NIA”), notification No. 13016/9/2014‐CA‐III 

dated Dec 26, 2014 of Ministry of Coal, the Allotment Agreement for the Coal Mine 

and the Mine Dossier shall be deemed to be a part of this Allotment Document. 

Subject to the provisions of Clause 4.10, the aforesaid documents and any addenda, 

corrigendum issued subsequent to this Allotment Document, will be deemed to form 

a part of the Allotment Document.  

3.1.2. The Applicants are required to register themselves on MSTC‟s website 

http://www.mstcecommerce.com to generate login ID and password. The Allotment 

Document for the Coal Mine can be downloaded from MSTC‟s website using the 

login ID and password. Allotment Document shall be available free of cost to each 

Applicant. 

3.1.3. The Applicants are required to examine all instructions, forms, terms, conditions, and 

other information contained or referred to in the Allotment Document. Failure to 

furnish all information required as per the Allotment Document or submission of an 

Application not substantially responsive to the Allotment Document in every respect 

will be at the Applicant‟s risk and may result in rejection of its Application. 

3.1.4. The Allotment Document is meant for the exclusive purpose of submitting an 

Application by the Applicant and shall not be transferred, reproduced or otherwise 

used for purposes other than for which it is specifically issued. 

3.1.5. At any time prior to the deadline for submission of Application, the Nominated 

Authority may, for any reason, whether at its own initiative, or in response to a 

clarification requested by a prospective Applicant, amend the Allotment Document. 

In order to afford prospective Applicants reasonable time in which to take the 

amendment into account in preparing their Application, the Nominated Authority 

may, at its discretion, extend the deadline for the submission of Application. 

3.2. Eligibility Requirement for Applicants 

3.2.1. Section 5(1) of the Act prescribes eligibility for allotment of Schedule I coal mines (as 

defined in the Act), which includes the Coal Mine. Applicants are required to ensure 

that they meet the conditions mentioned in Section 5(1) of the Act which is quoted 

below for reference: 

Section 5. (1) of the Act: 

http://www.mstcecommerce.com/
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“ 5 (1) Notwithstanding the provisions contained in sub-sections (1) and (3) of section 4, the 

Central Government may allot a Schedule I coal mine to a Government company or 

corporation or to a joint venture between two or more Government companies or corporations 

or to a company which has been awarded a power project on the basis of competitive bids for 

tariff (including Ultra Mega Power Projects) from specified Schedule I coal mines by making 

an allotment order in accordance with such rules as may be prescribed and the State 

Government shall grant a reconnaissance permit, prospecting licence or mining lease in 

respect of any area containing coal to such company or corporation: 

Provided that the Government company or corporation may carry on coal mining in any form 

either for its own consumption, sale or for any other purpose in accordance with the permit, 

prospecting licence or mining lease, as the case may be. 

Provided further that no company other than a Government company or corporation shall 

hold more than twenty-six percent of the paid up share capital in the Government company or 

corporation or in the joint venture between a Government company or corporation, either 

directly or through any of its subsidiary company or associate company. 

Provided also that a joint venture of any two or more Government companies or corporations 

shall be prohibited from alienating or transferring any interest, except the taking of loans or 

advances from a bank or financial institution, in the joint venture of whatsoever nature 

including ownership in favour of a third party.” 

3.2.2. However, an Applicant having coal linkage shall also be considered for Allotment for 

their existing Specified End Use Plant(s), if such Applicant commits to surrender their 

existing coal linkages for the same. The existing coal linkage shall then be tapered 

off/ reduced as per extant policy/ procedure specified by the Government. 

3.2.3. The Applicant who is a Prior Allottee must have paid the additional levy within the 

time period prescribed under Rule 18 of the Rules. It is clarified that if a Prior Allottee 

has not made payment of the applicable additional levy within the time prescribed 

under Rule 18 of the Rules, then no Allotment shall be made to such Prior Allottee.  

3.3. Digital Application 

3.3.1. Application(s) can only be submitted digitally on the electronic platform created by 

MSTC and no physical applications shall be accepted or considered. The 

Application(s) are required to be submitted on the website of MSTC in accordance 

with the instructions provided in Clause 5 (Instructions for Electronic Application). 
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3.3.2. In case of any technical clarification regarding access to the electronic platform or 

conduct of the allotment process, the Applicants may contact MSTC directly at the 

address provided in Clause 5.1.4. 

3.4. Description of Application Process 

3.4.1. The Allotment would be conducted in the manner specified in the Act, Rules, and 

any other order issued by the Central Government in this regard.  

3.4.2. The allotment process would comprise of the following steps: 

(a) The Applicants would be required to submit duly complete Applications on the 

electronic platform of MSTC in the manner specified in Clause 5 (Instructions for 

Electronic Application); 

(b) The duly completed Applications shall be opened and evaluated by the 

Nominated Authority for compliance with the Eligibility Conditions and shall be 

tested for responsiveness pursuant to Clause 3.5; 

(c) The Applications which are considered to be in compliance with all the Eligibility 

Conditions and is responsive pursuant to Clause 3.5, shall be considered for the 

purpose of selection from amongst the qualified Applicants in accordance with 

norms specified in Clause 6.1. Applicant selected on the basis of norms specified 

in Clause 6.1 shall be recommended as the “Preferred Applicant”.  

(d) Pursuant to Rule 11(8) of the Rules, the Nominated Authority shall recommend 

the name of the Preferred Applicant to the Central Government. Upon receipt of a 

direction from the Central Government that an Allotment Order should be issued 

to the Preferred Applicant, the Preferred Applicant shall be declared as the 

“Allottee”. 

(e) Notwithstanding the above, in the event that the Nominated Authority or the 

Central Government determines that a Preferred Applicant should not be 

declared the Allottee on account of any reason whatsoever, including without 

limitation the withdrawal of the Preferred Applicant from the allotment process 

for the Coal Mine or the Preferred Applicant ceasing to comply with the 

Eligibility Conditions, then the Coal Mine shall be allotted to applicant second in 

the preference order. 

(f) Upon receiving the direction from Central Government, the Nominated 

Authority shall inform the Allottee and execute the Allotment Agreement. The 

Allottee shall not be entitled to seek any deviation, modification or amendment in 
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the Allotment Agreement, except with the prior approval of the Central 

Government. 

3.4.3. Subsequent to signing of the Allotment Agreement, the Allottee shall, within such 

period as prescribed in Clause 3.6: 

(a) furnish the Performance Security as specified in Clause 7 and having provided such 

undertaking as specified in Allotment AgreementError! Reference source not 

found., in case the approved Mining Plan is not available; 

(b) pay a fixed amount for the value of Land and Mine Infrastructure; cost of 

preparation of geological report borne by the Prior Allottee; cost incurred by 

CMPDIL and other Government agencies in deriving detailed geological boundary 

coordinates and in preparing geological report and mining plan (as applicable); cost 

of obtaining all statutory licenses, permits, permissions, approvals, clearances or 

consents relevant to the mining operations, borne by the Prior Allottee (collectively 

the “Fixed Amount”). If the Allottee is a Prior Allottee, then, the compensation 

payable to such Allottee shall be set off or adjusted against the Fixed Amount 

payable by such Allottee. The Fixed Amount is required to be deposited by the 

Allottee with the Nominated Authority in accordance with the relevant provisions of 

the Act and the Rules. The Fixed Amount based on the available information and the 

assessment made by the competent authority will be uploaded as a part of the 

Allotment Document/ Mine Dossier. Any upward revision in the Fixed Amount on a 

subsequent date by the Government or the Nominated Authority consequent upon 

any process or on the orders of any competent court of law, shall also be payable by 

the Allottee. 

(c) pay the first instalment of the Upfront Amount as mentioned in Annexure VI against 

the Coal Mine and provide such undertaking to pay Upfront Amount as specified in 

Allotment Agreement in case the approved Mining Plan is not available. 

3.4.4. Upon receipt of Performance Security and other payments mentioned in Clause 3.4.3 

above, the Allotment Order shall be issued, in duplicate, by the Nominated Authority 

to the Allottee and the Allottee shall, within 7 (seven) days of the receipt of the 

Allotment Order, sign and return the duplicate copy of the Allotment Order in 

acknowledgement thereof. In the event the duplicate copy of the Allotment Order 

duly signed by the Allottee is not received by the stipulated date, the Nominated 

Authority may, unless it consents to extension of time for submission thereof, 

appropriate the Performance Security and other payments made by such Allottee as 

damages and also terminate the Allotment Agreement. 
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3.4.5. The Allottee shall be responsible for exploration (if required), obtaining all 

approvals/clearances, acquisition of land, as applicable, rehabilitation, financing, 

development, mining and the operation and maintenance of the Coal Mine, and 

subsequent closure of the Coal Mine in accordance with the provisions of the 

Allotment Order and the Allotment Agreement.  

3.5. Tests of Responsiveness 

3.5.1. Prior to evaluation of the Application, the Nominated Authority shall determine 

whether each Application is responsive to the requirements of this Allotment 

Document. The Nominated Authority reserves the right to reject any Application 

which is non-responsive and no request for alteration, modification, substitution or 

withdrawal shall be considered or permitted by the Nominated Authority in respect 

of such Application. While making any determination with respect to responsiveness 

of an Application, the Nominated Authority may consider such parameters as it may 

deem relevant, including considerations that the Application: 

a) is received as per the prescribed formats.; 

b) is received by the Last Date including any extension thereof; 

c) is submitted in the manner prescribed in this Allotment Document; 

d) is accompanied by a Power of Attorney as specified in Annexure I and an Affidavit as 

specified in Annexure II; 

e) contains all the information (complete in all respects) as requested in this Allotment 

Document; 

f) does not contain any condition or qualification;  

g) only 1 (one) Application has been made by the Applicant for the Coal Mine, either 

directly or indirectly and 

h) is generally considered to be responsive in terms of any other parameters as may be 

considered relevant by the Nominated Authority. 

3.6. Schedule of Allotment Process 

3.6.1. The Nominated Authority shall adhere to the following schedule: 

Sl. Event Description Estimated Date 

1 (i) Publication of Notice Inviting Application T0 Friday, 09 August, 2019  
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Sl. Event Description Estimated Date 

(NIA) in one English and one Hindi national 

newspaper, (ii) Publication of NIA on the 

website of MoC, (iii) Publication of NIA and 

Allotment Documents on website of MSTC Ltd 

The date of completion of the last sub-event 

among the above sub-events shall be 

considered T0 

2 Last date of receiving written requests for Site 

Visit/Land Document Inspection 

T0   +  7 Friday, 16 August 2019 

3 Pre-application meeting T0   +  14 Friday, 23 August 2019 

4 Last date of receiving written queries from 

Applicants 

T0   +  17 Monday, 26 August 2019 

5 Last date for written responses to queries by 

the Nominated Authority 

T0   +  21 Friday, 30 August 2019 

6 Last date for registration of Applicant at the 

website of MSTC 

T0   +  35 Friday, 13 September 

2019 

7 Last date for downloading Allotment 

Document at the website of MSTC 

T0   +  35 Friday, 13 September 

2019 

8 Last date for submission of Application (s) T0   +  41 Thursday, 19 September 

2019 

9 Opening of the Application (s) T0    +  45 Monday, 23 September 

2019 

10 Start date of examination of the Application (s) T0    +  46 Tuesday, 24 September 

2019 

11 End date of examination of the Application (s) T0    +  59 Monday, 07 October 2019 

12 Recommendation by the Nominated Authority 

to the Central Government  

T0   +  94 Monday, 11 November 

2019 

13 Approval of Allottee by the Central 

Government 

T1     

14 Intimation to the Allottee (subject to receipt of 

instruction from the Central Government) 

T1  +    2   

16 Execution of the Agreement between the 

Allottee and Nominated Authority 

T1  +    7   

17 Last date for furnishing of Performance 

Security and payment of Fixed and Upfront 

Amount by the Allottee 

T1  +  47   

18 Issuance of Allotment Order by Nominated 

Authority 

T1  +  50   

Note:  *Registration on the website of MSTC Ltd. will commence immediately after publication of the 

NIA. 

* Any change in timeline will be communicated through an addendum to the Allotment 

Document.   
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3.7. Upfront Amount 

3.7.1. The Allottee shall be required to pay the Upfront Amount as specified against each 

Coal Mine in Annexure VI. Upfront Amount is calculated as ten per cent (10%) of the 

value of the Coal Mine computed by compounding annuitized Reserve Price over 

mine life. The Upfront Amount shall be payable in following three instalments:  

a) 50% of the Upfront Amount shall be payable in accordance with Clause 3.4.3(c); 

b) 25% of the Upfront Amount shall be paid on or prior to expiry of 15 Business Days 

from the date of execution of mining lease Or on or prior to expiry of 15 Business 

Days from the date of issuance of notification under Section 11(1) of the CBA Act, 

1957; and 

c) the balance 25% of the Upfront Amount shall be paid on or prior to expiry of 15 

Business Days from the date grant of mine opening permission. 

3.8. Periodic Payments by Allottee 

3.8.1. In addition to the payments specified in Clause 3.4.3, the Allottee shall be required to 

make monthly payments with respect to the coal extracted from the Coal Mine on the 

basis of INR 100/Tonne (the “Reserve Price”). Such payments are required to be 

made within 20 calendar days of expiry of each month with respect to coal extracted 

from the Coal Mine in such calendar month. Additionally, the royalty payable on 

extracted coal will be payable as per Applicable Laws. 

3.8.2. The aforementioned payments shall be subject to yearly escalation on the basis of a 

Reference Index, with the prevailing Reference Index on the date on which the 

Allotment Order has been issued being considered as the base. The last published 

Reference Index shall be used for computing the escalation. 
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4. Instruction to Applicants 

4.1. General Instructions  

4.1.1. No Applicant shall submit more than 1 (one) Application for the Coal Mine, either 

directly or indirectly. However, the Applicant can apply for more than one Coal Mine 

for same Specified End Use Plant. 

4.1.2. Notwithstanding anything to the contrary contained in this Allotment Document, in 

the event of a conflict, the relevant provisions of the Allotment Agreement shall have 

overriding effect. 

4.1.3. The Nominated Authority reserves the right to postpone, cancel or call for fresh 

Application for the entire Allotment process without specifying any reason, at its 

own initiative or in response to any direction from the Central Government.  

4.1.4. The documents, including this Allotment Document and all attached documents, 

provided by the Nominated Authority are and shall remain or become the properties 

of the Nominated Authority and are transmitted to the Applicants solely for the 

purpose of preparation and submission of an Application in accordance herewith. 

Applicants are required to treat all such information as strictly confidential and shall 

not use it for any purpose other than for preparation and submission of their 

Application. The provisions of this Clause 4.1.4 shall also apply mutatis mutandis to 

Applications and all other documents submitted by the Applicants in relation to the 

Application, and the Nominated Authority will not return to the Applicants any 

Application, document or any information provided therewith. 

4.1.5. Any award of Allotment Order and execution of Allotment Agreement pursuant to 

this Allotment Document shall be subject to the terms hereof and any documents 

issued pursuant to the Act, the Rules, this Allotment Document or any other 

document referred herein. 

4.1.6. Applicants are also encouraged to revise the mining plan so as to mine at an 

accelerated rate, to the best of their capabilities. They are permitted to increase coal 

production from the mine to the maximum possible extent and utilise the coal for the 

same Specified End Use Plant(s) or any other plant of the Applicant or its subsidiary 

company for common Specified End Use in accordance with the provisions of the 

Section 20(2) of the Act with prior intimation to the Central Government. The Allottee 

may apply for coal linkages or participate in auction/ allotment three years prior to 

the exhaustion of extractable reserves in the Coal Mine. 
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4.2. Allotment Document, Queries and Clarifications 

4.2.1. Any queries or request for additional information concerning this Allotment 

Document may be sent by e-mail to the Nominated Authority at 

nomauthority.moc@nic.in substantially in the same format specified in Annexure III 

(Format for seeking clarifications regarding the Allotment Document). The email should 

clearly bear the following subject Line: “Queries/Request for Additional Information: 

Allotment Document for [insert name of the coal mine]”. The queries should be emailed in 

.doc, .docx, .xls, .xlsx format, on or before 1700 hours on the date specified in Clause 

3.6.1 for receiving queries.  

4.2.2. Each query should contain complete details of facts, information and Applicable Law 

germane to the query and also the particulars of the person posing the query. The 

Nominated Authority reserves the right to not answer any query, including any 

query which is incomplete or anonymous. 

4.2.3. The queries should be emailed on or before the date specified in Clause 3.6.1 for 

receiving queries.  

4.2.4. The Nominated Authority shall endeavour to respond to the queries within the 

period specified in Clause 3.6.1. However, the Nominated Authority reserves the 

right not to respond to any question or provide any clarification, in its sole discretion, 

and nothing in this Clause 4.2.4 shall be taken or read as compelling or requiring the 

Nominated Authority to respond to any question or to provide any clarification. The 

Nominated Authority may publish the queries and its responses thereto on the 

website of Ministry of Coal/MSTC, without identifying the source of queries. 

4.2.5. The Nominated Authority may also on its own motion, if deemed necessary, issue 

interpretations and clarifications to all Applicants. All clarifications and 

interpretations issued by the Nominated Authority shall be deemed to be part of the 

Allotment Document. Provided however that, any non-written clarifications and 

information provided by the Nominated Authority, its employees or representatives 

in any manner whatsoever shall not in any way or manner be binding on the 

Nominated Authority. 

4.2.6. Subsequent to opening of the Application, the Nominated Authority shall not 

entertain any query or clarification from Applicants who fail to meet the Eligibility 

Conditions. 

4.2.7. Applications shall be deemed to be under consideration immediately after the 

Applications are opened and until such time the Nominated Authority makes official 

mailto:nomauthority.moc@nic.in
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intimation of award/ rejection to the Applicants. While the Applications are under 

consideration, Applicants and/ or their representatives or other interested parties are 

advised to refrain, save and except as required under the Allotment Document, from 

contacting by any means, the Nominated Authority and/ or their employees/ 

representatives on matters related to the Applications under consideration. 

4.2.8. Save and except as provided in this Allotment Document, the Nominated Authority 

shall not entertain any correspondence with any Applicant in relation to acceptance 

or rejection of any Application.  

4.3. Pre-Application Meeting 

4.3.1. Pre-Application Meeting of the Applicants shall be convened on the designated date 

as mentioned in Clause 3.6.1 at a time and place specified by the Nominated 

Authority. Only those persons who have registered on the website of MSTC with 

respect to the allotment process shall be allowed to participate in the Pre-Application 

Meeting.  

4.3.2. A maximum of 3 (three) representatives of each Applicant shall be allowed to 

participate on production of duly issued authority letter from the Applicant and 

identity documents. During the course of Pre-Application Meeting, the Applicants 

will be free to seek clarifications and make suggestions for consideration of the 

Nominated Authority.  

4.3.3. The Nominated Authority shall endeavour to provide clarifications and such further 

information as it may, in its sole discretion, considered appropriate for facilitating a 

fair, transparent and competitive allotment process. 

4.4. Site Visits and Information 

4.4.1. Prior to submission of Application, the Applicants are encouraged to undertake the 

site visit to Coal Mine, at their cost and ascertain for themselves the site conditions, 

location, communication, climate, availability of power, Applicable Laws and 

regulations, and any other matter considered relevant by them in the manner 

provided herein. This Allotment Document does not however give the unconditional 

or unrestricted right to access the Coal Mine or the right to the Applicants to prospect 

for coal in the Coal Mine or carry out any drilling in the Coal Mine. 

4.4.2. The Applicants which have registered themselves at MSTC‟s website in accordance 

with Clause 5.1 shall be eligible to make a request for a visit to the Coal Mine until 3 

Business Days Prior to the Last Date. The site visit to the Coal Mine shall be 

coordinated through the following e-mail address na.moc@nic.in  

mailto:na.moc@nic.in
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4.4.3. The site visit to the Coal Mine shall be at the cost and risk of the Applicants making 

such request. In the event that such request is made prior to the „appointed date‟ (as 

defined in the Act), then the Nominated Authority may, in its discretion, issue an 

instruction to the Prior Allottee to facilitate the site visit. 

4.4.4. In the event an Applicant undertakes a site visit, then such Applicant shall be liable 

towards any loss or damage caused to the site and/or the Prior Allottee, on account 

of any act or omission of such Applicant or its employees, authorised representatives, 

agents, advisors etc. 

4.5. Submission of Application 

4.5.1. The Applications shall be submitted electronically in accordance with the process 

specified in Clause 5.4. 

4.5.2. In addition to submission of Application electronically, Applicants are also required 

to submit hard copy (ies) of following documents:  

(a) Affidavit in substantially the same format as provided in Annexure II;  

 

(b) Power of Attorney in substantially the same format as provided in Annexure 

I (Power of Attorney for Signing the Application), authorising the signatory of the 

Application to participate in the allotment process and do all acts pursuant 

thereto on behalf of the Applicant, including usage of the digital signature on 

behalf of the Applicant; and 

 
(c) Certified extract of the charter documents and certified true copy of the 

documents such as a board or shareholders resolution authorizing the execution 

of the Power of Attorney. 

 
In addition, an index of documents submitted should be annexed and the documents shall 

contain page numbers: Page [●] of [●] 

4.5.3. Above documents are required to be furnished in a sealed envelope, super scribed on 

the top as under and be addressed to the „Nominated Authority‟ at the address 

mentioned below: 

"Original Affidavit and Power of Attorney for Allotment of coal mines for 

[Name of coal mine] due on ……….….. (date of Application Opening) from 

M/s……………………… (MSTC Registration No. ………………)". 
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Nominated Authority 

Government of India 

Ministry of Coal 

Room No. 120, F-Wing, 

1st Floor, Shastri Bhawan 

New Delhi - 110001  

4.5.4. The Applicants are requested to send the Affidavit along with Power of Attorney and 

other documents as specified in Clause 4.5.2 well in advance so as to be received by 

the Nominated Authority before the Last Date failing which the Application shall not 

be opened. Nominated Authority shall not be liable for loss/non-receipt/late receipt 

of Affidavit or Power of Attorney and other documents as specified in Clause 4.5.2  in 

postal transit. 

4.5.5. The Application and all communications in relation to or concerning the Allotment 

Document and the Application shall be in English language. Wherever any document 

is provided in a language other than English, it should be accompanied by 

authenticated English translation of pertinent passages. In the event of any 

discrepancy in two versions, the English translation of the document will be accepted 

for the purpose of Application. 

4.6. Last Date of Submission of Application & Extension 

4.6.1. Applications should be submitted/ uploaded before 1700 hours IST on the Last Date 

in accordance with the process specified in Clause 5.4. 

4.6.2. The Nominated Authority may, in its sole discretion, extend the Last Date by issuing 

an Addendum in accordance with Clause 4.6.2 uniformly accessible for all 

Applicants. 

4.7. Modification/ Substitution/ Withdrawal of Applications 

4.7.1. The Applicant may modify, substitute or withdraw its Application after submission, 

provided that written notice of the modification, substitution or withdrawal is 

received by the Nominated Authority prior to the Last Date of Submission of 

Application in accordance with the process specified in Clause 5.4. No Application 

shall be modified, substituted or withdrawn by the Applicant on or after the Last 

Date. 
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4.7.2. Any alteration or modification in the Application or additional information supplied 

subsequent to the Last Date, unless the same has been expressly sought for by the 

Nominated Authority, shall be disregarded. 

4.8. Validity of Applications 

4.8.1. The Applications shall be valid for a period of not less than 150 (one hundred and 

fifty) days from the Last Date for submission of Application. The validity of 

Applications may be extended by mutual consent of the respective Applicants and 

the Nominated Authority. 

4.8.2. In the event that pursuant to the allotment process an Applicant has been declared to 

be the Preferred Applicant or Allottee, then the validity of Applications submitted by 

such Allottee shall stand extended by the mutual consent of the Preferred Applicant 

or the Allottee, as the case may be and the Nominated Authority. 

4.9. Rejection of Applications 

4.9.1. Notwithstanding anything contained in this Allotment Document, the Nominated 

Authority reserves the right to reject any Application and/or to annul the allotment 

process and reject all Applications at any time without any liability or any obligation 

for such acceptance, rejection or annulment, and without assigning any reasons 

thereof.  

4.9.2. The Nominated Authority reserves the right not to proceed with the allotment process 

at any time, without notice or liability, and to reject any Application without assigning 

any reasons. 

4.9.3. Without prejudice to the generality of the foregoing, the Nominated Authority 

reserves the right to reject any Application on any criteria specified in this Allotment 

Document, including without limitation, the following:  

a) Any Application which has not been submitted with all the information and 

details listed in this Allotment Document.  

b) Application is not responsive in terms of Clause 3.5.1.  

c) Any Application which has been submitted without the Affidavit, Power of 

Attorney or which is not valid for the period specified in Clause 4.8.1.  

d) Any Application which has not been submitted in accordance with the 

Allotment Document. 
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4.10. Amendment of Allotment Document 

4.10.1. At any time prior to the Last Date, the Nominated Authority may, for any reason, 

whether at its own initiative or in response to clarifications requested by an 

Applicant, modify the Allotment Document by the issuance of a Corrigendum 

and/or Addendum. 

4.10.2. Any clarification, Corrigendum and/or Addendum issued hereunder will be in 

writing and shall be accessible to all the Applicants and shall be deemed to be part of 

the Allotment Document. Any verbal clarification shall not be binding on Nominated 

Authority. 

4.10.3. In order to afford the Applicants a reasonable time for taking an Corrigendum 

and/or Addendum into account, or for any other reason, the Nominated Authority 

may, in its sole discretion, extend the Last Date. 

4.11. Cost of Application 

4.11.1. The Applicants shall be responsible for all the costs associated with the preparation of 

their Applications and their participation in the allotment process. The Nominated 

Authority will not be responsible or in any way liable for such costs, regardless of the 

conduct or outcome of the allotment process. 

4.12. Utilisation of Coal 

4.12.1. The Allottee shall not be permitted to use the coal extracted from the Coal Mine for 

any purposes other than utilisation for Specified End Use. Any middling or washery 

rejects generated from the Coal Mine may be utilised in any captive power plant of 

the Allottee. Any middling or washery rejects generated from the Coal Mine which 

cannot be utilised in the manner specified hereinabove may be sold by the Allottee 

only with the prior approval of the Coal Controller‟s Organisation and the Allottee 

shall maintain separate records for the middling or washery rejects generated, 

utilised and sold. However, the middling or wahsery rejects generated from the Coal 

Mine shall not exceed the normative limits. The normative limits for this purpose 

shall be decided as per the results of the washability test conducted by National 

Accreditation Board for Testing and Calibration Laboratories (NABL) certified 

laboratory. The Nominated Authority and/or Central Government shall reserve the 

right to conduct a separate washability test for this purpose. The Allottee shall be 

required to bear the cost of such washability test and the test report shall be 

submitted within one month from the start of coal production from the Coal Mine. 
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4.12.2. Notwithstanding anything contained in this Agreement, the Allottee shall utilise a 

minimum of 75% of the actual production (ROM basis) in the specified end use plants 

and is allowed to sell upto 25% of the actual production (ROM basis) in open market. 

The Allottee shall be required to pay an additional Reserve Price of 15% of the 

Reserve Price on per tonne basis, for the actual quantity of coal sold in open market. 

The additional Reserve Price will be over and above the Reserve Price. The Allottee 

shall adhere to the modalities/ guidelines issued by Central Government from time 

to time in this regard.  

4.12.3. Utilisation of coal for any other Specified End Use Plant of the Allottee shall also be 

permitted in accordance with Rule 20 of the Rules. Additionally, the Allottee shall 

also be permitted to enter into arrangements for optimal utilisation of the Coal Mine 

in accordance with Rule 19 of the Rules. 

4.12.4. Any coal which is extracted in excess of the requirement of the Allottee in terms of 

this Allotment Document, i.e., if due to maintenance or shutdown or such other 

unavoidable reasons, beyond the control of Allottee, during any part of the year, the 

Allottee is not able to use a minimum of 75% of actual production (ROM basis), in 

Specified End Use Plant or own consumption, such excess coal shall be required to be 

sold to CIL at the terms and conditions specified in the Allotment Agreement. 

Provided however, such sale should not exceed 50% of the annual production of coking 

coal [and non-coking coal respectively,] from the Coal Mine. 

4.12.5. In case, the Specified End Use Plant i.e. blast furnace is without a coke oven, then the 

Allottee may engage a third party for conversion of coking coal into coke. 

The normative limits for conversion of coking coal into gross coke shall be as per 

Office Memorandum F.No. 14(2)2017-RM-I dated May 26, 2017 issued by Ministry of 

Steel. The same has been provided in the Schedule J of the Allotment Agreement. 

4.13. Security 

4.13.1. Subject to Applicable Laws, the Allottee shall be entitled to create security over the 

Coal Mine through mortgage for the purposes of availing financing from a bank or 

financial institutions for the purposes of financing of the Specified End Use Plant or 

mining operations at the Coal Mine and such security creation shall not require prior 

approval by the Nominated Authority or the Central Government. 

4.13.2. In the event of a default, the banks or financial institutions, as the case may be shall 

be entitled to enforce their security interest in the manner provided by Applicable 
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Law, provided that any transferee of the Coal Mine meets all the Eligibility 

Conditions. 

4.14. Prohibition  

In the cases where Allotment has been made to a joint venture of any two or more 

Government companies or corporations, such companies shall be prohibited from 

alienating or transferring any interest, except for taking of loans or advances from a 

bank or financial institution, in the joint venture of whatsoever nature including 

ownership in favour of a third party.  
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5. Instructions for Electronic Application  

5.1. Registration on MSTC’s Website 

5.1.1. In order to submit Applications for the Coal Mine, an Applicant would be required to 

register itself with the e-auction website of MSTC: http://www.mstcecommerce.com. 

For this the Applicant should visit the website of MSTC and click on the button 

“Registration”. Applicant should read carefully the GENERAL TERMS & 

CONDITIONS OF e-AUCTION that will appear on screen and click on the 

“Proceed” button at the bottom of the page. Applicant should also read the 

subsequent APPLICANT SPECIFIC TERMS & CONDITIONS (BSTC) and click on 

“Agree” to proceed for registration. An online Registration Form will appear on 

screen and Applicant would be required to fill up the same. During this process, 

Applicant would be required to create its “User ID” and “password” and keep note 

of the same. Applicant should ensure that the secrecy of its User ID and password is 

maintained at all time and Applicant shall alone be responsible for any misuse of the 

User ID and password. Applicant may also refer to the “Applicant‟s Guide” available 

online in the above mentioned website for assistance. 

5.1.2. On successful submission of the online registration form, Applicant shall receive a 

confirmation e-mail at the registered email address advising the Applicant to submit 

the following documents: 

a) Self attested Income Tax PAN Card of the Applicant. 

b) Two passport size photographs of the Authorized Signatory of the Applicant. 

c) Letter of Authorization from Chairman/MD/Directors/CEO/Company 

Secretary of the Applicant in favour of the Authorized Signatory in the standard 

format available in the website. The Authorized Signatory shall be the person 

responsible for submission of Application. For this purpose, the Authorized 

Signatory will need to be in possession of a Class III signing type digital 

signature issued by an Indian certifying authority, the details of which shall be 

provided in this authorization letter.  

d) Proof of Identity of the Authorized Signatory in the form of Company ID 

Card/PAN Card/Voter ID Card 

e) Copy of the confirmation email. 

5.1.3. Applicant shall be required to electronically submit all the above documents to MSTC 

for verification and activation of their account. Applicants are required to send 
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scanned copies of the aforementioned documents to the following designated email 

address: 

coalblock@mstcindia.co.in 

5.1.4. It may be noted that Applicants need not visit any of the offices of MSTC for 

submission of the aforementioned documents. However, the Applicants may contact 

the following offices of MSTC for seeking assistance on the login or registration 

process. 

MSTC Limited 
E-Commerce Division 
225-F, A.J.C Bose Road, 2nd Floor Kolkata - 700 020 

 
 
5.1.5. Once the complete set of aforementioned documents is electronically received from 

an Applicant, MSTC shall activate the Applicant‟s login after verification / scrutiny 

of the documents. MSTC reserves the right to call for additional documents from the 

Applicant if required, prior to registration and activation of the Applicant‟s login. 

5.1.6. On completion of the above stated registration process, an Applicant shall be able to 

log in to MSTC‟s website. After activation of login, an Applicant will be issued a 

“Photo Identity Card” by MSTC bearing the photograph and signature of the contact 

person. The Photo Identity Card shall be duly authenticated by MSTC‟s officials. 

5.1.7. The Applicants are also needed to submit a Declaration in the format provided in the 

MSTC‟s website (www.mstcecommerce.com/auctionhome/coalblock/index.jsp) 

stating that the applicant is a Government company or corporation. This declaration 

is to be submitted after registration by email to coalblock@mstcindia.co.in with the 

subject line “Declaration by Government Companies for allotment of coal mines.” 

5.1.8. Applicants who have registered earlier with the website need not register again.  

5.2. Downloading Information About Coal Mine 

5.2.1. There are two sets of documents available for downloading from the website of 

MSTC.  

5.2.2. First set of documents can be downloaded without registration on MSTC‟s website. 

These documents may include the following: (a) Standard format of the Allotment 

Document. Subsequent to registration, Applicants may download the second set of 

documents, including: (a) the Mine Dossier specific to the Coal Mine; and (b) 

Allotment Document. 

mailto:coalblock@mstcindia.co.in
http://www.mstcecommerce.com/auctionhome/coalblock/index.jsp
mailto:coalblock@mstcindia.co.in
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5.2.3. Information available on the website of MSTC without registration is provided in 

order to assist the potential Applicants to make a determination regarding their 

participation in the Allotment process. Based on such determination, potential 

Applicants may decide to participate in the Allotment process with respect to one or 

more coal mines. 

5.2.4. The Applicant may note that the files containing information about the coal mines 

can be in various formats including without limitation, doc, xls, ppt, pdf, jpg, jpeg, 

zip etc. and it shall be the responsibility of the Applicant to have suitable facilities at 

its end to download the uploaded files. 

5.3. Digital Signature Certificate 

5.3.1. An Applicant shall be required to possess a valid Digital Signature Certificate (DSC) 

of signing type to be able to submit its Application and to participate in the electronic 

auction on MSTC‟s website. For this purpose, Applicants shall be required to 

authorize its Authorized Signatory to procure a class III DSC of signing type from 

any Certifying Authority or their authorized agencies in India.  

5.3.2. The competent authority of the Applicant shall be required to issue a Letter of 

Authority in favour of the Authorized Representative in the standard format 

provided on the homepage of the website of MSTC mentioning therein the serial 

number of the DSC of the Authorized Representative. The competent authority shall 

be one of the following: 

a) Chairman of the Company 

b) Managing Director of the Company 

c) Chief Executive Officer of the Company 

d) Company Secretary of the Company 

5.3.3. The Applicant may note that only one User ID will be mapped with a given DSC for 

the Authorised Signatory. DSC once mapped with a particular User ID of an 

Applicant will normally not be changed and therefore Applicants are advised to 

carefully select the DSC before forwarding the same to MSTC for mapping. 

5.3.4. The Digital Signature Certificate will be used to digitally sign the Applications that 

the Applicant will submit online.  

5.3.5. It will be the sole responsibility of the Applicant and its respective Authorised 

Signatory to maintain the secrecy of the password for the Digital Signature 
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Certificate. The Applicant shall be solely responsible for any misuse of the DSC and 

no complain or representation in this regard shall be entertained at any stage by 

MSTC or the Nominated Authority. 

5.3.6. The Applicant may note that the following configurations will be required to be 

undertaken in their Internet Explorer browsers for smooth functioning of the website. 

5.3.7. The system requirements are as follows: 

a) Operating System –Windows 7 and above 

 

b) Web Browser- Preferred „IE 8‟ and above. 

 

c) Security Settings :  

i) Tools=>Internet Options=>Security=>Disable protected Mode If enabled-i.e., 

Remove the tick from the box mentioning “Enable Protected Mode”. 

ii) Tools => Internet Options => Security =>Custom Level=> 

 Active X control & plug-ins: Enable all Active-X Controls  

 Scripting: Enable “Allow Status Bar Update Via Script” 

 Disable “Use Pop-up Blocker” 

 

d) Java: JRE 8 Latest update 

 

e) Other Settings: 

i) View => Toolbars=> “Tick” Status Bar. 

ii) Tools=>Internet Options=> General=> Click on Settings under “Browsing 

history/Delete Browsing History”=> Temporary Internet Files=>Activate 

“Every time I Visit the Webpage”. 

f) For new Version of IE or other “Active –X Filtering” under Tools should not be 

ticked. 

g) Tools =>Internet Options=> Security=> Selected Trusted Sites=> Add Website 

“http://www.mstcecommerce.com” 

5.4. Application Process 

5.4.1. The entire Application process will be in single stage and will be online on MSTC‟s 

website.  

5.4.2. The intending applicants may send a letter in their official letterhead addressed to 

MSTC Limited Kolkata mentioning the name of the coal mine(s) for which they wish 

to make application for allotment. Based on the said letter, MSTC shall enable the 

applicant to download the Mine Dossier specific to the Coal Mine; and Allotment 

Document. The scanned copy of the letter may be sent to the email mentioned below 
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droy@mstcindia.co.in  

5.4.3. The submission of Application shall be open to all Applicants who have registered 

for the Coal Mine. In this process, the Applicant, after logging in to the above stated 

website, will have to click on the link “View Details”. In the next page, the Applicant 

shall have to go to the link “Allotment of Coal Mines”. Thereafter, the Applicant will 

have a bouquet under “My Menu” having 3 (three) sub-menus – “Bid Floor 

Manager”, “Upload Documents” and “Attach Documents”. 

5.4.4. Bid Floor Manager 

5.4.4.1. Once the Applicant clicks on this sub-menu, it will display a list of Coal Mine(s) for 

which the Applicant has registered for downloading the remaining documents. On 

clicking on any of these Coal Mine(s), the Applicant will be directed to a screen 

where it can fill up the Application template and save the data. The Applicant can 

edit such data as many times as it wishes till the final submission is made by 

clicking the “Final Submission” button. 

5.4.4.2. The final submission of Application shall be digitally signed by the Applicant using 

the digital signature, use of which has been duly authorized on behalf of the 

Applicant and which was used at the time of registration. Any digital signature 

certificate other than the above shall not be acceptable for Application submission 

by the system. 

5.4.5. The Applicant may note that the “Final Submission” button for Application will be 

activated only after the Application has been saved. 

5.4.6. The Applicant should also note that an Application will be considered as submitted if 

and only if the Applicant has clicked on the “Final Submission” button. Only such 

Applications will be opened which have been finally submitted. It is further clarified 

that saving of Application without final submission will be treated as non submission 

of Application. 

5.4.7. The Applicant shall also have to upload the documents (Formats as per Annexure IV, 

scanned copies of Affidavit, Power of Attorney, Board Resolution etc) along with the 

Application, as required under the Allotment Document. These documents will need 

to be uploaded in pdf format only (the file size should be limited to 4 MB; in case of 

larger files, they may be split into multiple files with suitable nomenclature). Files in 

formats other than pdf shall not be accepted. For this, the Applicant shall first click on 

the link “Upload documents” and upload the files in support of its Application. 

mailto:droy@mstcindia.co.in
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5.4.8. After uploading these documents, the Applicant shall have to attach them with the 

specific Coal Mine(s) for which it is intending to submit the Application. It may be 

noted by the Applicant that in case it intends to use the same document for more than 

one Coal Mine, it does not need to upload the same document every time. The 

document, once uploaded, can be attached with Applications for multiple mine(s), if 

desired. 

5.4.9. The Applicant should note that only a file which is “attached” with a specific Coal 

Mine(s) shall be considered during evaluation of the Application. Files which are not 

attached to any Coal Mine(s) shall not be considered for evaluation. 

5.4.10. Upon successful final submission, the Applicant shall receive a system generated 

Application acknowledgement. 

5.4.11. If after final submission of Application and before the Last Date an Applicant wishes 

to make changes in its Application, it can do so by clicking the “Delete Application” 

option. By doing so, the entire Application submitted by the Applicant will get 

deleted. A system generated email will be sent to the Applicant acknowledging the 

deletion. The Applicant will be able to save and submit its new Application again. If 

an Applicant deletes its Application and does not submit its new Application in the 

same manner as stated above, its Application will not come up for opening or further 

processing. 

5.4.12. If after final submission of Application and before the Last Date an Applicant wishes 

to withdraw its Application, it can do so by clicking the “Withdraw Application” 

option. By withdrawing an Application, Applicant will lose the opportunity to re-

submit its Application against the Coal Mine(s). 

5.4.13. The Applicants shall also note that online submission of Application with documents 

and offline submission of certain original documents shall be allowed only up to time 

specified in “Schedule of Allotment Process” (Clause 3.6.1). Applicants in their own 

interest are advised to complete the entire process well in advance to avoid any last 

minute hiccup / technical problems. No complaints shall be entertained in this 

regard at any stage. 

5.4.14. Applicants should note that words „Bidder‟ and „Technical Bid‟ have been used 

interchangeably with „Applicant‟ and „Application‟ on the Digital platform. 
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6. Evaluation Criteria 

6.1. Evaluation of Applications 

The Applications which are considered to be responsive pursuant to Clause 3.5 and 

in compliance with all the Eligibility Conditions, then such Applications shall be 

considered for the purpose of selection amongst the qualified Applicants in the 

following manner: 

a) In the event that only one Application is considered to be responsive pursuant to 

Clause 3.5 and in compliance with all the Eligibility Conditions, the Applicant which 

submitted such Application shall be recommended as the “Preferred Allottee”.  

b) In the event that more than one Applications are considered to be responsive 

pursuant to Clause 3.5 and in compliance with all the Eligibility Conditions, then 

such Applications shall be considered for the purpose of selection from amongst the 

qualified Applicants in accordance with the following norms: 

i) Only those Applicants having Specified End Use Plants with unmet coal 

requirement shall be considered for further evaluation. In this case, unmet 

coal requirement shall mean 150% of the annual coal requirement of the 

Specified End Use Plants taken over a period of 30 (thirty) years less the 

requirement of coal of such Specified End Use Plants met from any other coal 

mine (as a percentage of extractable reserves) allocated to the Applicant as 

Preferred Allottee, Allottee, Preferred Bidder, Successful Bidder, as the case 

may be, pursuant to any other auction or allotment process (including the 

current tranche VII of allotment) conducted by the Nominated Authority or 

Ministry of Coal under the Act and under the MMDR Act, 1957 or any other 

coal mine for which Mining Lease has been granted to the Allottee under 

Applicable Law. 

 

Illustration: Solely for the purpose of reference of Applicants, the methodology of 

calculating unmet coal requirement of the Applicant is illustrated below: 

Assuming the Applicant has submitted its Application for Coal Mine Y having extractable 

reserve of 30 mt, Washery II grade. The Specified End Use Plant of the Applicant is a 5 

MTPA blast furnace. The Applicant has already been allotted a Coal Mine X having 

extractable reserves of 50 mt, Washery I grade for the Specified End Use Plant. 
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The annual coal requirement of the Specified End Use Plant in case of mine X shall be 

calculated as: 

Normative Coal Consumption Norm for Washery I grade: 365 kg/tonne of hot metal 

Annual Coal Requirement at 85% PLF= 5 * 365 * 85%/1000 = 1.55 mt/annum 

30 year Coal Requirement = 30 * 1.55 = 46.54 mt 

150% of 30 year Coal Requirement = 150% * 46.54 = 69.81 mt 

% coal requirement met through mine X = 50/69.81 = 71.63% 

 

The unmet coal requirement of the Specified End Use Plant in case of mine Y shall be 

calculated as: 

Normative Coal Consumption Norm for Washery II grade: 470 kg/tonne of hot metal 

Annual Coal Requirement at 85% PLF = 5 * 470 * 85%/1000 = 2.00 mt/annum 

30 year Coal Requirement = 30 * 2.00 = 60.00 mt 

150% of 30 year Coal Requirement = 150% * 60.00 = 90.00 mt 

% coal requirement met through mine X = 71.63% 

Unmet coal requirement = 90.00 * (1-71.63%) = 25.53 mt 

 

Since the Applicant has unmet coal requirement even after allotment of mine X, the 

Applicant may be considered for allotment of Mine Y in accordance with the norms 

specified. Assuming mine Y is also allocated to the Applicant, Applicant‟s total coal 

requirement shall be fulfilled by mine X and mine Y, and the Applicant shall not be eligible 

for further allotment of coal mines under the current tranche (Tranche VII) of allotment. 

 

ii) A score shall be calculated for remaining Applicants on the basis of the 

following criteria: 

S. No. Criteria Score Weightage 

1 

Distance of the Specified End Use Plant from the 

Coal Mine* 

 

50% 

Distance <=250 km 10.0 

250 km < Distance <= 500 km 7.5 

500 km < Distance <= 750 km 5.0 

750 km < Distance <= 1000 km 2.5 

Distance > 1000 km 0 
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S. No. Criteria Score Weightage 

2 

Status of development of the Specified End Use 

Plant  

(Refer Note 2 below) 

 

50% 

Consent to Operate certificate has been obtained from 

the State Pollution Control Board 

10 

Stage II Forest Clearance has been obtained from 

Ministry of Environment, Forest and Climate Change 

(MoEF&CC)* 

7 

Environment Clearance has been obtained from 

MoEF&CC* 

4 

Consent to Operate, Stage II Forest Clearance  and 

Environment Clearance has not been obtained 

0 

*In case Forest Clearance is not required to be obtained for a Specified End Use Plant and 
Environment Clearance has been obtained for the Specified End Use Plant, a score of 7 shall be 
assigned for such Specified End Use Plants. 
 
Note:  
1. In case of multiple Specified End Use Plants, individual score shall be estimated for each such 

Specified End Use Plant and a weighted average (estimated on the basis of capacity of 
Specified End Use Plant) of such scores shall be considered as the Applicant’s score for the 
purpose of evaluation. 

2. Applicants are required to submit a copy of i) Consent to Operate certificate issued by State 
Pollution Control Board, ii) Stage II Forest Clearance and iii) Environment Clearance, as the 
case may be, for the Specified End Use Plant. Such certificates are required to be submitted on 
MSTC’s website in accordance with Clause 5.4.7.    
 

Applicants shall be ranked in descending order on the basis of calculated scores and the 

Applicant at Rank 1 i.e. the Applicant with the highest score shall be recommended as the 

“Preferred Allottee”. 

However, in case two or more qualified Applicants secure Rank 1, then the following tie-

breaking criteria shall be considered: 

Applicant who has paid more royalty to the State Governments during previous financial 

year i.e. FY 2018-19, shall be recommended as the “Preferred Allottee”. The amount of 

royalty paid shall be certified by the statutory auditor of the Applicant and the certificate is 

required to be submitted on MSTC‟s website in accordance with Clause 5.4.7. 
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7. Performance Security  

7.1. Instructions Related to Performance Bank Guarantee  

7.1.1. The Allottee shall provide to the Government an irrevocable and unconditional 

guarantee from an Acceptable Bank at Delhi, for the performance of its obligations 

within such time as specified in Clause 3.6.  

The Performance Security shall be the aggregate amount of: (a) one year royalty 

calculated on the basis of peak rated capacity of the Coal Mine as per the approved 

mining plan, payable to respective State Government with respect to the Coal Mine; 

and (b) the annual peak rated capacity of the Coal Mine as per the approved mining 

plan multiplied by the Reserve Price. The Performance Security shall be in 

substantially the form as provided in the Allotment Agreement. 

For the purpose of computation of the amount of Performance Security, 90% of peak 

rated capacity shall be considered in case of opencast mines and 80% of peak rated 

capacity shall be considered in case of underground mines. 

However, in case of regionally explored coal mines, the Performance Security shall be 

equal to 10% (ten percent) of the estimated exploration expense during the 

exploration period i.e. till completion of exploration and preparation and submission 

of Geological Report in accordance with the Allotment Agreement. 

7.1.2. The amount of Performance Security shall be revised in following events: 

a) Every financial year, the amount of Performance Security shall be revised 

upwards on the basis of escalation to the amount of Reserve Price as specified 

in Clause 3.8.2. It is clarified that for the purposes of escalation in a subsequent 

financial year, the escalated Reserve Price of the immediately preceding year 

shall be considered. The subject escalation would be applicable after the 

issuance of the Allotment Order;  and/or 

b) In case of any revision in rate of royalty, the amount of Performance Security 

shall be revised accordingly. Such revision shall take place at the beginning of 

the financial year which is subsequent to the financial year in which the rate of 

royalty is revised, as stipulated in Clause 7.1.3; and/or 

c) In case of any revision in CIL Notified Price, the amount of Performance 

Security shall be revised accordingly. Such revision shall take place at the 

beginning of the financial year which is subsequent to the financial year in 

which the CIL Notified Price is revised, as stipulated in Clause 7.1.3; and/or 
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d) In case of any revision in the mining plan in accordance with Clause 8.1, the 

amount of Performance Security shall be revised accordingly upon approval of 

revision to the mining plan. Such revision shall take place at the beginning of 

the financial year which is subsequent to the financial year in which the mining 

plan is revised, as stipulated in Clause 7.1.3. 

It is clarified that revisions to the amount of Performance Security may occur under 

sub-clause (a), (b), (c) and (d) above, simultaneously, if such sub-clauses are 

applicable. 

7.1.3. The revision to the amount of Performance Security shall be carried out once in every 

financial year. Upon such revision, the bank guarantee constituting the Performance 

Security shall be substituted with another bank guarantee of the revised value issued 

in accordance with this Clause 7, within a period of 30 days of revision of the 

Reference Index in the month of April, in case of revision under each of sub-clause 

(a), (b), (c) and (d) of Clause 7.1.2. 

7.1.4. The Performance Security should remain valid for such duration as specified in the 

Allotment Agreement. 

7.2. Appropriation of Performance Security 

7.2.1. The Performance Security may be appropriated by the Nominated Authority in the 

manner specified in the Allotment Agreement. 
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8. Other Provisions 

8.1. Revision of Mining Plan upon allocation  

8.1.1. Upon allocation of the Coal Mine, the Allottee may revise the mining plan for 

extraction of more coal in accordance with the provisions of Applicable Law and the 

Allotment Agreement. 

8.2. Flexibility in Production 

8.2.1. The Allottee shall produce coal not below 80% of scheduled production in a year in 

opencast mine and not below 70% in case of underground mine subject to the 

condition that Allottee shall not produce coal  less than 90% of scheduled production 

in any five year block in opencast mine and 80% in case of underground mine. It is 

clarified that five year block shall be counted from the first financial year of 

commencement of production in the Coal Mine. 

8.3. Miscellaneous 

8.3.1. The allotment process shall be governed by, and construed in accordance with the 

laws of India and the dispute resolution shall be subject to Section 27 of the Act. 

8.3.2. The Nominated Authority, in its sole discretion and without incurring any obligation 

or liability, reserves the right, at any time, to; 

a) suspend and/ or cancel the allotment process and/ or amend and/ or 

supplement the allotment process or modify the dates or other terms and 

conditions relating thereto; 

b) consult with any Applicant in order to receive clarification or further 

information; 

c) retain any information and/ or evidence submitted to the Nominated Authority 

by, on behalf of, and/ or in relation to any Applicant; and/ or 

d) independently verify, disqualify, reject and/ or accept any and all submissions 

or other information and/ or evidence submitted by or on behalf of any 

Applicant. 

8.3.3. It shall be deemed that by submitting the Application, the Applicant agrees and 

releases the Nominated Authority, its employees, agents and advisers, irrevocably, 

unconditionally, fully and finally from any and all liability for claims, losses, 

damages, costs, expenses or liabilities in any way related to or arising from the 
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exercise of any rights and/ or performance of any obligations hereunder, pursuant 

hereto and/ or in connection with the allotment process and waives, to the fullest 

extent permitted by Applicable Laws, any and all rights and/or claims it may have in 

this respect, whether actual or contingent, whether present or in future. 

8.3.4. An Applicant having coal linkage for the Specified End Use Plant shall surrender 

such coal linkage without any reservation or condition in case the Applicant is 

declared as Allottee in accordance with Clause 3.2.2.  

8.4. Proprietary Data 

8.4.1. All documents and other information supplied by an Applicant to the Nominated 

Authority shall remain or become the property of the Nominated Authority. It will 

not return any Application or any information provided by the Applicant. 
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9. Annexure I: Format of Power of Attorney 

 

 

(To be stamped in accordance with relevant Stamp Act) 

Power of Attorney for signing of Application 

Know all men by these presents, We, …………………………… (name and address of the 

registered office) do hereby irrevocably constitute, nominate, appoint and authorise Mr. 

/ Ms (Name), son/daughter/wife of ……………………………… and presently residing 

at ………………………………….., who is presently employed with us and holding the 

position of ………………………….., as our true and lawful attorney (hereinafter referred 

to as the “Attorney”) to do in our name and on our behalf, all such acts, deeds and 

things as are necessary or required in connection with or incidental to submission of our 

Application for the [_______________] Coal Mine (“Coal Mine”) in response to the 

Allotment Document dated [______________] issued by Nominated Authority, Ministry 

of Coal (the “Nominated Authority”) including but not limited to signing and 

submission of all applications, affidavits and other documents and writings, participate 

in applicants‟ and other conferences and providing information / responses to the 

Nominated Authority, representing us in all matters before the Nominated Authority, 

and generally dealing with the Nominated Authority in all matters in connection with or 

relating to or arising out of our application for the said Coal Mine and/or upon award 

thereof to us and/or till the entering into of the Allotment Agreement with the 

Nominated Authority.  

AND we hereby agree to ratify and confirm and do hereby ratify and confirm all acts, 

deeds and things done or caused to be done by our said Attorney pursuant to and in 

exercise of the powers conferred by this power of attorney and that all acts, deeds and 

things done by our said Attorney in exercise of the powers hereby conferred shall and 

shall always be deemed to have been done by us.  

IN WITNESS WHEREOF WE, ………………………….., THE ABOVE NAMED 

PRINCIPAL HAVE EXECUTED THIS POWER OF ATTORNEY ON THIS 

……………………… DAY OF …………………….., 20.…..  

 

For……………………………..  

(Signature, name, designation and address)  
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Witnesses:  

1.  

2.  

Accepted Notarised  

(Signature, name, designation and address of the Attorney)  

Notes:  

The mode of execution of the power of attorney should be in accordance with the procedure, if any, 

laid down by the Applicable Law and the charter documents of the executant(s) and when it is so 

required, the same should be under common seal affixed in accordance with the required 

procedure.  

Wherever required, the Applicant should submit for verification the extract of the charter 

documents and documents such as a board or shareholders resolution authorizing the execution of 

this power of attorney.  

To be submitted separately for each Application. 

 

 



Page 40 of 51 

 

10. Annexure II: Format of Affidavit 

To be submitted separately for each Application. 

 (To be stamped in accordance with the relevant Stamp act and duly sworn before Notary public) 

Affidavit 

 

I, ____________________ aged ______ years, resident of __________ working as ____________ 

an authorised signatory on behalf of _________________________ (name of Applicant) (the 

“Applicant”) hereby state as under: 

  

1.  I say that I am the [Insert designation of the deponent] of the Applicant. I am 

conversant with the facts and circumstances surrounding the subject of this Affidavit 

and have been authorized to depose to the same pursuant to the power of attorney 

dated____________. I am filing this Affidavit to place on record verification of facts 

and documents in connection with the allotment process concerning [insert name of 

the coal mine].    

 

2. That the Applicant has coal linkage [insert details of coal linkage and linked Specified 

End Use Plant(s)] and commits to surrender such coal linkage without any 

reservation or condition in case the Applicant is declared as Allottee.  

3.  [Insert separate paragraphs for each document brought on record on the website of 

the MSTC or physically submitted with the Nominated Authority, in a chronological 

sequence]. 

 

4.  That nothing has been concealed in the information submitted as mentioned above.  

Solemnly affirmed and verified on this ______ day of (month) 2018 at (place).  

 

 

(Signature) 

Name, Designation & Seal 

VERIFICATION 

 

I, [●], the [Insert designation of the deponent] of the Applicant above named, having my 

office at [●], do hereby solemnly declare that what is stated above in paragraphs [●] to [●] 

are on the basis of the books and records of the Applicants, and verify that the contents of 

the above affidavit are true and correct, no part of it is false and nothing material has been 

concealed there from. 

 

Verified at ______ day of (month) 2019 at (place). 
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Deponent 

(Signature) 

   Name, Designation & Seal 
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11. Annexure – III: Format for Seeking Clarifications. 
 
 
 

(Applicable only for the Pre-Application meeting before submission of the Application in 

response to the Allotment Document)  

 

S. No Document Clause No. 
and Existing 
Provision 

Clarification 
Required 

Suggested Text 
for 
Amendment, if 
any 

Rationale for 
Clarification or 
Amendment 
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12. Annexure – IV: Formats to be submitted by the Applicants 

SCHEDULE I Application Form 

SCHEDULE II General Information 

* Above Schedules are to be filled, signed, stamped, scanned and uploaded alongwith Application on 

the MSTC’s digital platform. 
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SCHEDULE I: APPLICATION FORM 

ALLOTMENT OF COAL MINES TO ELIGIBLE APPLICANTS FOR SPECIFIED END 

USE  

Applicant's Ref. No.:  

Applicant's Name & 

Address  

 

 

 

 

 

Person to be contacted   

Designation   

Tel. No(s).    

Mobile No.   

Fax No(s).  

E-mail address  

 

To  

The Nominated Authority 

Ministry of Coal 

Government of India 

Shastri Bhawan, 

New Delhi - 110001 

 

Dear Sirs,  

Having read and examined in detail the Conditions of Allotment Document dated ……… 

and subsequent Amendment(s) Nos and Clarification(s) Nos, we do hereby furnish our 

Application for Allotment of [name of coal mine] Coal Mine as mentioned at number 

………. of the list of coal mines at Annexure VI available for coal extracted from the coal 

mine to be used for own consumption for generation of power.  

We have understood the instructions and the terms & conditions mentioned in the 

Allotment Document furnished by you and have thoroughly examined the specifications of 

the aforementioned Coal Mine as provided by you in the Allotment Document and are fully 

aware of the technical and other details of the Coal Mine and are otherwise fully satisfied 

with respect to the information provided.  

We further confirm that no change or substitution in respect of reference Coal Mine, as 

specified in the Allotment Document, for meeting the specified Eligibility Conditions shall 

be offered by Applicant. 

We understand that it is not mandatory for you to open our Application and it will be 

opened only if we are otherwise eligible for participating in the Allotment process. We 

understand and confirm that your decision in this regard shall be final and binding on us.  

We understand and agree that the Nominated Authority does not bind themselves to accept 

any application or to give any reasons for their decision. The decision of the Nominated 
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Authority shall be final and binding on us in all matters /issues arising out this allotment 

process.  

We confirm that we have furnished all the relevant information in respect of coal mines to 

the Nominated Authority for Specified End Use in the following Schedules: 

SCHEDULE I Application Form 

SCHEDULE II General Information 

 

We further agree that if our proposal is accepted, we shall provide an irrevocable 

Performance Guarantee in your favour in the form of Bank Guarantee of amount calculated 

on the basis of formula specified in Clause 7.1.1 before the date of issue of Allotment Order, 

in accordance with Clause 7.1.1 of Allotment Document. 

We confirm that our Application shall remain valid for your acceptance for a period of One 

Fifty (150) days from the Last Date of submission of the Application. 

We hereby declare that only the Company, persons or firms interested in this proposal as 

principal or principals are named herein and that no other company, person or firm other 

than one mentioned herein, have any interest in this Application or in the Allotment 

Agreement to be entered into, if we are awarded this Coal Mine, and that this Application is 

made without any connection with any other persons, firm or party likewise submitting an 

Application and that this Application is in all respects for and in good faith without 

collusion or fraud. 

In terms of Clause 4.5.2(b) of Allotment Document, we are enclosing herewith power of 

Attorney & affidavit in the name of the person who has signed this offer on behalf of the 

firm. 

Date Signature 

Place 

Name of Authorized Signatory 

 

 

 Designation 

 Company‟s Name 

 



Page 46 of 51 

 

SCHEDULE II: GENERAL INFORMATION  

ALLOTMENT OF COAL BLOCKS TO ELIGIBLE APPLICANTS FOR SPECIFIED END 

USE 

(Data/information in respect of Eligibility criteria: as per Clause 6.1 of Allotment Document) 

In line with the requirement of the Clause 6.1 of Allotment Document. 

S.N. Parameter  

1.  Name of Applicant  

2.  Registered Address  

3.  Name of shareholders equal to or more than 26% shareholding  

4.  Specified End Use Plant (s)*  

4.1.  Name  

4.2.  Capacity (MW)  

4.3.  Location   

4.4.  Distance of the Plant from specified railhead in Annexure VI (km)  

4.5.  Coal Requirement (MTPA)**  

4.6.  Whether Consent to Operate has been obtained or not (Yes/ No)  

4.7.  Whether Stage II Forest Clearance has been obtained or not (Yes/ No)  

4.8.  Whether Environment Clearance has been obtained or not (Yes/ No)  

4.9.  Coal Linkage (in MTPA), if any***  

5.  Amount of royalty paid during FY 2018-19 in accordance with 

Clause Error! Reference source not found. 

 

* if the Application is for multiple End Use Plants, information required under 4.1 to 4.9 should be 

furnished for each of the End Use Plant. 

 

** Coal requirement shall be calculated on the basis of following benchmarks  
Estimation of annual coal requirement for production of hot metal through blast furnace: 
For steel, the coal consumption given is on kg/tonne basis. Applicants will have to calculate 
their coal requirement at 85% capacity utilisation. 
 

Name of Mine Grade of Coal Steel (kg of coal/tonne of Hot 
Metal) 

Sitanala Washery-III 600 
 
For the sake of clarity, it is mentioned that the capacity of blast furnace as mentioned above 
shall be considered for determination of coal requirement. The requirement of a coke oven 
battery with the blast furnace is not necessary. Applicants having a blast furnace without a 
coke oven battery shall also be eligible to participate in the auction. Coal requirement of any 
other upstream and downstream products and corresponding plants like rolling mill, sinter 
plant, producer gas plant, iron ore pellets, ferro alloys, rolled and structural steel, other steel 
products, washery and transit losses, etc. shall not be considered.  
 

***in case of existing coal linkage, the Applicant shall add a separate paragraph in the affidavit for 

each Specified End Use Plant for surrender of coal linkage. 
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Date Signature 

Place 

Name of Authorized Signatory 

 

 

 Designation 

 
Company‟s Name 
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13. Annexure – V: Allotment Agreement 

<<<<to be provided>>>>>>> 



 

14. Annexure –VI: Particulars of the Coal Mine and Upfront Amount 

 

S. 

No. 

Coal 

Mine 

Prior Allottee Specified 

End Use 

Nearest 

Railhead 

Distance 

from 

Nearest 

Railhead 

(km) 

Fixed 

Amount 

(Rs.) 

Upfront Amount (Rs.) 

First 

Installment 

Second 

Installment 

Third 

Installment 

1 Sitanala Steel Authority of 

India Ltd. 

Production 

of iron & 

steel (coking 

coal) 

Shibbabudih 0.5 To be 

provided 

separately 

 90,09,701.00   45,04,850.50   45,04,850.50  

 

 

 

 

 

 



 

Important Notice 

 
The information contained in this Allotment Document or subsequently provided to Applicant(s), by 
or on behalf of the Nominated Authority or any of its employees or advisors, is provided to 
Applicant(s) on the terms and conditions set out in this Allotment Document. 

This Allotment Document is neither an agreement nor an offer by the Nominated Authority to the 
prospective Applicants or any other Person. The purpose of this Allotment Document is to provide 
interested parties with information that may be useful to them in making their Applications pursuant 
to this Allotment Document. This Allotment Document includes statements which reflect various 
assumptions and assessments arrived at by the Nominated Authority in relation to the Coal Mine. 
Such assumptions, assessments and statements do not purport to contain all the information that each 
Applicant may require. This Allotment Document may not be appropriate for all Persons, and it is 
not possible for the Nominated Authority, its employees or advisors to consider the investment 
objectives, financial situation and particular needs of each party who reads or uses this Allotment 
Document. The assumptions, assessments, statements and information contained in the Allotment 
Document, including specifically the Mine Dossier, may not be complete, accurate, adequate or 
correct. Each Applicant should, therefore, conduct its own investigations and analysis and should 
check the accuracy, adequacy, correctness, reliability and completeness of the assumptions, 
assessments, statements and information contained in this Allotment Document and obtain 
independent advice from appropriate sources.  

Information provided in this Allotment Document to the Applicant(s) has been collated from several 
sources some of which may depend upon interpretation of Applicable Law. The information given is 
not intended to be an exhaustive account of statutory requirements and should not be regarded as 
complete. The Nominated Authority accepts no responsibility for the accuracy or otherwise for any 
statement contained in this Allotment Document.  

The Nominated Authority, its employees and advisors make no representation or warranty and shall 
have no liability to any Person, including any Applicant under any law, statute, rules or regulations 
or tort, principles of restitution or unjust enrichment or otherwise for any loss, damages, cost or 
expense which may arise from or be incurred or suffered on account of anything contained in this 
Allotment Document or otherwise, including the accuracy, adequacy, correctness, completeness or 
reliability of the Allotment Document and any assessment, assumption, statement or information 
contained therein or deemed to form part of this Allotment Document or arising in any way from 
participation in this Allotment process.  

The Nominated Authority also accepts no liability of any nature whether resulting from negligence or 
otherwise howsoever caused arising from reliance of any Applicant upon the statements contained in 
this Allotment Document.  

The Nominated Authority may in its absolute discretion, but without being under any obligation to 
do so, update, amend or supplement the information, assessment or assumptions contained in this 
Allotment Document.  

The issue of this Allotment Document does not imply that the Nominated Authority is bound to select 
a Applicant or to appoint the Preferred Applicant as Allottee for the Coal Mine and the Nominated 
Authority reserves the right to reject all or any of the Applicants or Applications without assigning 
any reason whatsoever.  

Each Applicant shall bear all its costs associated with or relating to the preparation and submission of 
its Application including but not limited to preparation, copying, postage, delivery fees, expenses 
associated with any demonstrations or presentations which may be required by the Nominated 
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Authority or any other costs incurred in connection with or relating to its Application. This 
Allotment Document is not transferable.  

The Mine Dossier of the Coal Mine is being provided only as a preliminary reference document by 
way of assistance to the Applicants who are expected to carry out their own surveys, investigations 
and other detailed examination of the Coal Mine before submitting their Applications. Nothing 
contained in the Mine Dossier shall be binding on the Nominated Authority nor confer any right on 
the Applicants, and the Nominated Authority shall have no liability whatsoever in relation to or 
arising out of any or all contents of the Mine Dossier. 

 


